- User Interface Reference
- Keyboard Shortcuts
Welcome to ConceptDraw PRO v11 for Windows

ToolBar Tour

Quick Access .................................................................................................................. 3
Help Menu ....................................................................................................................... 4
File .................................................................................................................................. 5
  Print ................................................................................................................................. 7
Home ................................................................................................................................. 8
  Select ............................................................................................................................... 10
  Tools ................................................................................................................................. 11
  Flowchart ......................................................................................................................... 12
Shape ................................................................................................................................. 13
  Rapid Draw ....................................................................................................................... 16
  Text .................................................................................................................................. 17
  Operations ......................................................................................................................... 18
Document .......................................................................................................................... 19
View ................................................................................................................................... 21
Share ................................................................................................................................. 23
Developer .......................................................................................................................... 24
  Shape Parameters Table ................................................................................................. 25
Modal Dialogs ................................................................................................................... 26
  Color ................................................................................................................................. 27
  Define Custom Properties ............................................................................................... 28
  Properties ......................................................................................................................... 30
  Edit User .......................................................................................................................... 35
  Find/Replace .................................................................................................................... 36
  Flash Export Settings ...................................................................................................... 37
  Grid&Rulers ...................................................................................................................... 38
  HTML Export Wizard ...................................................................................................... 40
  Image Properties ............................................................................................................ 41
  Insert Table Sections ....................................................................................................... 42
  Library Item Properties ................................................................................................. 43
  Library Properties ......................................................................................................... 44
  Page Properties .............................................................................................................. 45
  Login ................................................................................................................................. 46
  Open .................................................................................................................................. 47
  Paste Special .................................................................................................................... 48
  Options .............................................................................................................................. 49
  Save .................................................................................................................................. 55

© 2018 CS Odessa corp.
Welcome to ConceptDraw PRO v11 for Windows

Computer Systems Odessa Corporation introduces you ConceptDraw PRO - a world-class diagramming software that lets you display, communicate, and present dynamically on Mac and PC platforms. ConceptDraw PRO is powerful enough to draw everything from basic flowcharts to complex engineering schematics.

World-Class Diagramming
Benefits
ConceptDraw Maintenance Assurance
Technical Support

World-Class Diagramming
ConceptDraw PRO is a diagramming tool that lets you easily create diagrams in minutes to support any business communication process. You can create simple or complex drawings to communicate status or condition to your audience.

ConceptDraw PRO creates drawings, diagrams and charts with great visual appeal. It is simple to express ideas to share with others that quickly convey what you are thinking when using ConceptDraw PRO. ConceptDraw PRO is a spectacular, easy-to-use tool for preparing presentations and business documentation, describing structures and processes, making schematic diagrams, and drawing technical sketches.

ConceptDraw PRO is powerful enough to be the standard-bearer business graphic tool for organizations of any size, producing rich visual documents that convey meaning and support company’s internal and external communication needs. Graphic company communications include dashboards displaying key performance indicators and depiction of processes based on company data. From simple to complex, ConceptDraw PRO fills every niche.

Your Benefits
Simplifies and enhances presentation generation with flexible slide construction, automated processes, and Live Object technology for displaying external data. Contains an extensive library of over 20,000 ready-to-use objects, with hundreds of templates and examples to get you started quickly.

ConceptDraw PRO also supports dynamic presentations that contain live content and can be edited on the fly to reflect input from collaboration or feedback. Presentations can be exported to numerous graphical formats or emailed as a slide show. ConceptDraw PRO presentations can be displayed in full-screen, automated playback mode, or using dual monitors — display on one, edit on the other — for team collaboration.

ConceptDraw Maintenance Assurance
We have developed an innovative maintenance program that makes sure you stay up to date. At the time of your buy a ConceptDraw product, you are able to purchase ConceptDraw Maintenance Assurance

Technical Support
We offer unlimited free technical support to our users.
To send us a problem report or feature request, submit the ticket form in the Help Desk section on our Web site.
Replies are normally sent within one business day. We are always happy to answer your questions and hear your feedback.
Toolbar Tour

The ConceptDraw PRO v11 toolbar provides quick access to functions that are commonly performed within the program.

Quick Access
File
Home
Shape
Document
View
Share
Developer
Quick Access

Quick Access menu facilitates access to the most frequently used functions. It is located at the top of Toolbar.

- **New Document** - Create new blank document
- **Open** - Open existing document
- **Undo** - Undo the last action
- **Redo** - Redo the last undone action
- **Save** - Save the current document
- **Print Preview** - Preview and make changes to pages before printing
- **Customize Quick Access Toolbar** - Customize Quick Access Toolbar
**Help Menu**

- **ConceptDraw PRO Help**: Calls the ConceptDraw PRO Help System. It opens in a separate window where you can see a number of articles containing information on how to use the product. You can read or print the articles, search them for the needed information.
- **Keyboard Shortcuts**: Calls the ConceptDraw PRO ready-to-print list of the keyboard shortcuts in pdf format.
- **Getting Started**: Opens the Getting Started guide in the PDF format.
- **Online Help Desk**: Allows you to ask a question to ConceptDraw PRO Support Team.
- **Check for Update**: Runs ConceptDraw STORE and opens the Available Updates tab.
- **About ConceptDraw**: Opens the About window, where you can see the information about the application version and developers.
**File**

**New:** Create a new blank document  
**Template Setup:** Open **Template Setup** Dialog  
**Open:** Launch an existing ConceptDraw PRO document using **Open** modal dialog  
**Recent:** Show recently opened files  
**Save:** Save the current document using **save** as dialog  
**Save As:** Save the document as ConceptDraw PRO document, as ConceptDraw PRO Template, or as ConceptDraw PRO Presentation  
**Import:** Import data from other file formats  
**Export:** Save ConceptDraw PRO document (cddz) as other file type  
**Library:** Open, and save libraries  
**Print:** Preview and print the document.  
**Send via e-mail:** Send a copy of the file in an e-mail as an attachment  
**Close:** Close a document  
**Properties:** Show Document Properties dialog  
**Options:** Show the Options dialog

**Import**

- **Graphic File:** Import data from graphic formats (emf, wmf, pict, pict, bmp, dib, gif, jpeg, jpg, png, tif, tiff)  
- **Microsoft PowerPoint:** Import data from Microsoft Office PowerPoint Document (.pptx, ppt)  
- **Microsoft Visio Drawings:** Import data from Microsoft Visio Drawing (vsd, .vsdx, vdx)  
- **Microsoft Visio Stencils:** Import data from Microsoft Visio Stencil (.vssx, vss)
Export

- **Adobe Flash (SWF)**: Save document as Adobe Flash (SWF) file, using [Flash Export Settings](#) dialog.
- **Adobe Acrobat (PDF)**: Save document as Adobe Acrobat (PDF) file.
- **EPS**: Save document as Encapsulated PostScript (EPS) vector file.
- **Graphic File**: Save document as [graphic file](#) (emf, bmp, dib, gif, jpeg, jpg, png, svg, tif, tiff).
- **HTML**: Save document as [HTML file](#).
- **Microsoft PowerPoint**: Save document as Microsoft Office PowerPoint Document (.pptx, .ppt).
- **Microsoft Visio 2010 (VDX)**: Save document as Microsoft Visio 2003-2010 Drawing (.vdx) file.
- **Microsoft Visio 2013 (VSDX)**: Save document as Microsoft Visio Drawing (.vsdx) file.
- **SVG**: Save document as SVG file.

Library

- **New**: Create new library.
- **Open**: Open an existing library.
- **Save**: Save active library.
- **Close All Save as**: Save a copy of active library.
- **Send via email**: Send an active library via e-mail.
- **Close**: Close the active library of the current document.
- **Close all**: Close all libraries used in the current document.
- **Properties**: Show [Library Properties](#) dialog box.
Print - send the ConceptDraw PRO document directly to the default printer without making changes.

Print Preview - view the document and make changes to pages before printing.

Print: Preview and print document
Select Printer: Change default printer
Print Setup: Show Printer Setup dialog box
Options: Show/hide grid lines and background for printing
Range: Select the range of pages that you want to print
Size: Select the paper size
Orientation: Switch between portrait and landscape layouts
Drawing Justification: Select margins for current document
Scale: Select the print scale
Previous Page: View previous page of document
Next Page: View next page of document
Close Print Preview: Close Print Preview and return to edit
Clipboard

The clipboard group includes functions that enable you to copy and paste data.

- **Paste** - Paste Clipboard contents.
- **Paste Special** - Activate Paste Special dialog.
- **Paste Special as Previous** - Paste special into the same place as previous.
- **Paste in a Place** - Paste object over the copied object.

- **Cut (Ctrl+X)** - Cut the selection and put it on the Clipboard.
- **Copy (Ctrl+C)** - Copy selection and place in Clipboard.
- **Duplicate** - Create duplicate of selected object

Text Format

You can change the format of text in a selected object using these text formatting options.

Select the drawing object that contains the text that you want to format. Click the formatting buttons that you want to use, or Right-click the selected object and use context menu to open Text Properties dialog.

Solutions

Here you can access the content of solutions. Use the button to open Solutions Panel.
Select

To make changes to an object, or to a text within it, you need to select it first, and for some changes, you need to select multiple shapes. Here you can find a set of selection tools designed to work with the selected objects.

Tools

You can create your own custom objects by using the rectangle, ellipse, line and other drawing tools from Tools group.

Flowchart

Flowcharts are diagrams that show the steps in a process. Basic flowcharts are easy to create and, because the shapes are simple and visual, they are easy to understand. ConceptDraw PRO comes with a set of Flowchart tools designed to simplify flowcharts creation.

Panels

Access to Arrange and Format floating panels.

Editing

You can perform text edits and substitutions of selected objects.

Open the Find/Replace dialog box (Ctrl+Alt+F)

Check the text spelling.

You can change the selected object by another using the following options:

Selected Objects with Primary: Change the selected object to the primary object.
Selected with Library Object (Ctrl+Space): Change the object selected on a document page to the selected library object.
Library Object with Selected (Ctrl+Shift+I): Change the selected library object to the object selected on a document page.
Select

Selection Tool is active by default.
To select a single shape, point Selection tool to the object. When the pointer turns into a four-headed arrow, click the object. Green handles appear on the shape when you select it.

When you want to change a number of objects, you can select multiple objects to work with them all at once. Point Selection tool to the object. Place the pointer above and to the left of the objects you want to select, and then drag to create a selection area around the objects. After you select the shapes, you’ll see green selection handles around the primary object. Other objects will have blue selection handles.

ConceptDraw PRO provides several tools for selecting objects. Knowing how to use each tool makes working with objects easy.

Select Next Object - Select the next object following the order of creation.
Select Previous Object - Select the previous object following the order of creation.
Select All (Ctrl+A) - Select all objects on the page.
Select Connected objects.
Select all objects that are connected to selected object.
Delete Selected Objects - Delete the selected objects.
Delete Selected Links - Delete Selected Connectors.
Activate Eyedropper tool. The Eyedropper tool is used to sample a color from an image to use this color further.

Text Selection Tool
Activate the Text Selection tool when you need to edit a text in ConceptDraw document.

Click the mouse once to activate the edit mode
Double-click to select the whole word.
Drawing Tools

Rectangle (Ctrl+7) - Click in the upper left corner of where you want to place your rectangle and drag to the lower right corner to define the rectangle. To draw a square, hold the Shift key down while dragging down and across the screen.

TextBox (Ctrl+2) - Insert, remove and resize text. Double-Click or press F2 to start text edits

Line (Ctrl+3) - Draw line

Spline (Ctrl+6) - Draw a freeform line

Ellipse (Ctrl+8) - Click in the upper left corner of where you want to place your ellipse and drag to the lower right corner to define the ellipse. To draw a circle, hold the Shift key down while dragging down and across the screen.

Direct Connector - Draw Direct Connector between objects. Click on the object you want to connect and drag to other object to connect it.

Arc (Ctrl+5)

Edit Vertex - Activate this tool to see the vertices of the object. You can change the form of object by dragging the vertex. Drag the vertex where you want it and then release the mouse button.
Flowchart

Connector
ConceptDraw PRO makes it easy to connect objects in your drawing. You can use one of the the Connector tools. To connect elements using this tool, drag the connector from one connect point to another. Direct Connectors are straight lines from the point of origin to the point of contact. Smart, Arc, Bezier and Curve Connectors are drawn very similarly to Direct Connectors. However, they can automatically route around objects already placed in your drawing.

- Direct Connector
- Arc Connector
- Bezier Connector
- Smart Connector
- Curve Connector

Activate Clone Tool. Click any place of document to insert copy of selected object. Press Escape to turn off the Clone Tool.

Activate the Chain Connection Mode.
Consistently connect selected objects with Connectors. New object will be automatically connected to selected one. You can change the connector's appearance using the Format panel.

Activate the Tree Connection Mode.
Connect selected objects with Connectors in a tree structure. New object will be automatically connected to selected one. You can change the connector's appearance Using the Format panel.

Activate snapping an object to neighboring objects.
Shape

Insert
Text
Point
Run Around Objects
Operations
Properties

Insert
When working on a document in ConceptDraw PRO, you can perform some inserts..

Insert Picture
Hypernote
Rapid Draw

Insert Picture
Insert picture from file

Hypernote:
Activate the Hypernote Panel

Rapid Draw
Activate the Rapid Draw functionality for selected objects

Text
Several elements are involved in working with the text of an object.

Fit to Text
Text Handle Bound
**Point**
Point Connection Mode.

Activate Connection Point tool. You can add any number of connection points to selected object as well as to empty space in your document.

**Run Around Objects**
ConceptDraw PRO makes it easy to connect objects in your drawing. Connectors will automatically route around objects already placed in your drawing. Use this button before you start drawing when you would like to disable routing around objects. You can manage

**Operations**
Sometimes the best way to draw a custom object is to take several standard objects and combine or change them to get the desired geometry. Using functionality from the Operations group, you can create your custom unique objects out of the geometry of standard library objects.
Properties
ConceptDraw PRO gives the opportunity to work with the object properties. You can change the default object properties, and define your own, custom properties.

Shape Properties - Activate the Shape Properties dialog. This dialog is used to modify the default properties of an object.

Custom Properties - Edit object’s custom properties using the Custom Properties dialog or define them using the Define Custom Properties dialog.
Rapid Draw capability allows you to build professional diagram quickly and easily. Add the start point of your chart and simply select a directional arrow from the selected object. Rapid Draw will automatically draw and connect the next object in your diagram.
**Text**

- **Fit to text**: Make the sizes of object appropriate to the text size

![Fit to text example]

- **Text Handle**: Add text handle to change alignment of text inside object

![Text Handle example]

- **Text Bound**: Set text boundaries within the object

![Text Bound example]
**Operations**

**Edit Vertex:** Activate this tool to see the vertices of the object. You can change the form of object by dragging the vertex. Drag the vertex where you want it and then release the mouse button.

**Add vertex:** ConceptDraw PRO provides vertices on all its objects, but there may not be enough for your purposes. You can add your own vertices. Select an object and use the Vertex tool to add vertex to the shape. The cursor will look like a crossed circle. Left mouse-click to add vertex to the shape. Change the shape form by dragging the vertex.

**Cut Edges:** Cut the object's edges.

**Join:** Joining selected objects into a single shape, if they are unclosed figures. For example lines, arcs e.t.c. If they are closed figures such as rectangle or circle, this command will act the same as the Combine command.

**Combine:** Combine the selected figures into a solid multi-component figure.

**Separate:** Separate combined objects.
Document

Add page: Add a blank page at the end of the document

Delete Page: Delete page from the document

Page Navigator: Activate Pages panel

Page navigation controllers: Buttons to scroll pages

Create Background: Add new page and set it as background page for the current page or for all pages.

Set as Background: Set the selected page as a background to other pages. By default, the new page is not a background page.

Choose Background: Assign a background for the selected page from a list of all document's pages. By default, the new page has no background.

Orientation: Switch page between portrait and landscape layout.

Width: Change page width.

Height: Change page height.

Lock proportions: Keep page proportions when changing page size.

Adjust to Content: Apply the page size to fit page content.

Size: Select a page size or a display size using the drop down list.
Connectors Routing

- Change the type of connector crossing.
  - Square
  - Arc
  - 2 Sides
  - 3 Sides
  - Gap

- Change the layout of gap between connectors
  - Horizontal layout
  - Vertical layout
  - No Gaps

Change the type of connector crossing.

Square
Arc
2 Sides
3 Sides
Gap

Change the layout of gap between connectors

Horizontal layout
Vertical layout
No Gaps
View

**Side Panels**

- **Libraries** - Activate the Library panel
- **Layers** - Activate the Layers panel
- **Info** - Activate the Info panel

**View**

- **Rulers** - Show/Hide rulers
- **Grid** - Show/Hide Grid
- **Guides** - Show/Hide Guidelines
- **Page Breaks** - Show/Hide Page Breaks
- **Size Boxes** - Show/Hide an object dimensions using editable size boxes

**Zoom**

- **Zoom In** - Zoom in on the document.
- **Zoom Out** - Zoom out of the document.
- **Zoom to Whole Page** (Ctrl+Shift +0) - Zoom document so that the page fills entire window
- **Zoom to all Objects** - Zoom document so that all objects are visible
- **Zoom Box** - Zoom in on the document so that selected area fills entire window
- **Scroll Hand** - Activate the Scroll Hand tool that allows one to easily move the page.
- **Zoom** - Choose a standard level within the 50% - 400% range, or set "Whole Page", "Page Width" or "All Objects".
Windows & Panels

Panels
- Activate the Floating Dialogs panel

Library - Open Library panel
Solutions - Open Solutions panel
Pages - Open Pages panel
Layers - Open Layers panel
Arrange - Open Arrange panel
Format - Open Format panel
Hypernote - Open Hypernote panel
Presentation - Open Presentation panel
Info - Open Info panel
Custom Properties - Open Custom Properties panel
Advanced - Open Advanced panel
Output - Open ConceptDraw Basic Editor window
Colors - Referred to the Colors panel on the bottom of application window.
Status Bar - Show Status Bar
Restore Panels State - Restore the default Panels view

Window

New Window - Open a new window containing the current document.
Cascade Windows - Cascade arrangement of opened windows.
Tile Windows Horizontally - Horizontal arrangement of opened windows.
Tile Windows Vertically - Vertical arrangement of opened windows.
Close (Ctrl+W) - Close an active window.
Close All - Close all open windows.
Share

Panel

**Presentation**: Open [Presentation](#) panel

Email

**Send via email**: Send a copy of the current document in an email message as an attachment

Exports

**Adobe Flash**: Save document as Adobe Flash (SWF) file, using [Flash Export Settings](#) dialog

**Adobe PDF**: Save document as Adobe Acrobat (PDF) file

**EPS**: Save document as Encapsulated PostScript (EPS) vector file

**Graphic File**: Save document as [graphic file](#) (emf, bmp, dib, gif, jpeg, jpg, png, svg, tif, tiff)

**HTML**: Save document as [HTML file](#)

**MS PowerPoint**: Save document as Microsoft Office PowerPoint 97-2003 Presentation (.ppt)

**MS Visio (VDX)**: Save document as Microsoft Visio 2003-2010 Drawing (.vdx) file

**MS Visio (VSDX)**: Save document as Microsoft Visio Drawing (.vsdx) file

**SVG**: Save document as SVG file
Developer

Developer tab is used to operate with ConceptDraw Basic Script. It is disabled by default. Use the View tab in the Options dialog to activate it.

Each ConceptDraw graphical object has a set of properties that define its view and functionality in the application. ConceptDraw offers some options to access properties of objects: a table of properties, and the ConceptDraw Basic. The object properties table gives the opportunity to work with the already defined set of parameters and properties of an object. It is designed to manage the limited (including large) set of properties. ConceptDraw Basic Script helps to interact with other applications (command line running, invocation of the custom functions from external libraries). ConceptDraw Basic Script allows you to create and work with complex objects, the objects with a variable number of child elements, and custom properties, as well as pre-defined behavior.

The application, document, page and even object can contain a ConceptDraw Basic Script. This means that any document, page or ConceptDraw object, can contain some program written in ConceptDraw Basic script. Script at any level is compiled and run at startup of the corresponding object. Initially, the application is loaded. The primary level of the script execution is the Application level. When you download a document, first run a Document script, then Page script and finally the Shape script.
**Shape Parameters Table**

Each ConceptDraw graphical object has a set of properties that define its view and functionality in the application. With the help of Shape Parameters table you can define the logic of the objects’ behavior, apply them the arbitrary appearance and set the connection between the appearances of different objects as well as create complex objects.

The object properties table gives the opportunity to work with the already defined set of parameters and properties of an object. It is designed to manage the limited (including large) set of properties.

You can manage the tables sections using Insert Table Section and View Sections dialogs.

For more complex objects, objects with a variable number of child elements and custom properties, as well as a predetermined behavior ConceptDraw Basic script is recommended.
Modal Dialogs

These dialogs are mostly called from the menus, or by using the keyboard shortcuts. While this dialog is open, you can't work with other dialogs or tools. As a rule, modal dialogs have several standard buttons:

**OK** - closes the dialog and applies the changes.

**Cancel** - closes the dialog without applying the changes.

**Apply** - applies the changes without closing the dialog.

**Help (?)** - displays context help.

The settings are not applied until you click the **OK** or **Apply** buttons.

Color
Define Custom Properties
Edit User
Find/Replace
Flash Export Settings
Grid&Rulers
HTML Export Wizard
Image Properties
Insert Table Sections
Library Item Properties
Library Properties
Login
Open
Options
Page Properties
Paste Special
Properties
Save
Shape Properties
Snap and Glue Settings
Spell Check
Template Setup
Text Properties
View Sections
Color

This dialog is used to set color for a shape, its text or other attributes. You can call this dialog by choosing the Other... from the appropriate button of Format panel.

The Color dialog:

To choose the needed color, click on it with the mouse.

Current - shows the currently chosen color.
Old - shows the color being changed.

You can specify a color manually in one of the two available color schemes: RGB or CMYK. The currently chosen scheme is shown in the drop-down list:

- RGB Scheme
- CMYK Scheme

The R(ed), G(reen), B(lue) or C(yan), Magenta, Y(ellow), (black)K slide bars allow to change each component of the color scheme.

Note: In the RGB Scheme the color components may range from 0 to 255; in the CMYK Scheme the components are shown in percents and may range from 0 to 100

A slider allows you to add transparency to your objects in order to make them more attractive or if you want to see objects located under. Move slider to the right to increase the transparency of the object and to the left to decrease it.
System - calls the system color dialog.
Define Custom Properties

This dialog is used to create, modify and delete custom properties of a shape. This dialog can be called by clicking the Define button in the Custom Properties dialog or by clicking on Custom Properties button on the Shape tab if custom properties are not defined yet.

The Define Custom Properties dialog:

![Define Custom Properties dialog](image)

The Properties section in the lower part of the dialog contains a list of custom properties of the shape. To modify or view a property in the upper part of the dialog, click on its name in the list.

- **New** - creates a new property and adds it to the list.
- **Delete** - deletes the property, selected in the table.

Each custom property is described by the following fields:

- **Label** - the name of the property. It's used when the property is referenced to in formulas or CD Basic scripts.
- **Type** - the type of the property, can have one of the following values:
  - String
  - Number
  - Fixed List
  - Variable List
  - Boolean
**Note:** The information about the type is used in the Custom Properties dialog: when entering values of the Fixed List, Variable List or Boolean types you're offered to choose one from the list. Also information about types can be used by CD Basic.

*Format* - contains the list of possible values for the properties that have the Fixed List or Variable List types. The values are delimited by semicolon ";". For values of other types this parameter is ignored.  
*Value* - indicates the default value,  
*Prompt* - the text of the tip,  
*Invisible* - specifies whether to show this property in the Custom Properties dialog,  
*Verify* - if enabled, checks if the property has a value, and if it doesn't, the user will be asked to provide one.
Properties

This dialog is used to set the parameters of the current document. To call it choose Properties... from the File menu.

The dialog contains several tabs, which control various groups of settings:
- **Print Setup** - contains information that describes the document
- **Page Size** - sets the size and orientation of the document pages
- **Info** - contains information that describes the document
- **Units, Scale, Shadow Options** - sets the scale, units of measure, etc.
- **Advanced** - contains settings that control access, export to HTML, the behavior of connectors.

**Print Setup** tab

*Printer paper* - lets you select printer paper size from the list.
*Portrait/Landscape* - defines the document page orientation.
*Setup...* - opens the system printer settings dialog.
*Print Zoom* - lets you adjust the document pages to the printer pages.
*Justification* - defines the justification of the document page on the printer page.
*Print background pages separately* - lets you print the background pages of the document as separate pages.
The left part of the tab contains the settings. The right part has the preview area, where you can see the results of the changes you apply. The document page is represented by the white rectangle, the printer page is represented by the shaded rectangle. The size and orientation of the printer page are taken from the current print settings.

*Document Size* setting allows to choose the size of the document page. The following options are available:

- *Same as printer paper size* - the document page has the same size as the printer page.
- *Pre-defined size* - allows to choose one of the pre-defined sizes from the drop-down list.
- *Custom size* - lets you set a custom page size:
  - *Width* - specifies the page width
  - *Height* - specifies the page height

*Adjust to drawing contents* - the page size is set enough to fit all shapes in the drawing. If the document contains several pages, the biggest value is used.
Info tab

- **Title** - contains the title of the document
- **Keywords** - in this field you can enter the keywords which the search engines will use to include the given document in their search results.
- **Author** - contains the name of the author
- **Company** - contains the name of the company
- **Description** - a detailed description of the document
Units of measure - allows to choose the unit of measure from the drop-down list.
Display angles in - sets whether to display the angles in degrees or radians.
The Scale setting determines the scale of the document. The following options are available:
No scale (1:1) - the 1:1 scale.
Pre-defined scale - allows to choose a scale from the list. The scale is set with the help of two drop-down lists. The first one allows to choose the type of the drawing:
- Metric
- Civil Engineering
- Mechanical Engineering
- Architectural
Depending on the chosen option you can choose a pre-defined scale in the second drop-down list. If the Civil Engineering or Architectural options are chosen, non-metric (imperial) units of measure are set automatically in the Units of measure field. You can change the units of measure manually if needed.
Custom scale - sets a user-defined scale. You can use different units of measure by specifying the appropriate suffix after the value (for example, 1 ft = 1 in).
Shadow Options - indicate the shadow offset for the shapes with shadow:
- Offset right - the distance that shadow is offset to the right
- Offset down - the distance that shadow is offset down.
The **Connectors and Routing** section contains settings that describe the behavior of smart connectors. 

**Max. numbers of legs** - sets the maximum number of connector's legs. By default the number of legs is not limited.

**Min. distance to shape** - sets the minimum distance the smart connector keeps from the shapes on its way.

**Line jump size** - indicates the size of connector crossings.

**Note**: This setting only determines the size, not the type and style of the crossing (see the **Connectors Routing** section).

**When crossing groups** - sets how the connector behaves when it crosses a group:

- **Pass through** - passes through the group, flowing around the shapes inside.
- **Flow around** - flows around the entire group as if it were a single shape.

The **Protect Access to Document** area lets you limit access to the document. The program will ask for a user name and password on an attempt to open the document. Only authorized users will be able to view and edit the document.

**Add User** - adds a new user to the list,

**Edit User** - allows to change the user name and password,

**Remove User** - deletes user from the list.
**Edit User**

This dialog is used to edit user details. You can limit access to the document to authorized users only.

This dialog is called when you click the **Add User** or **Edit User** buttons in the **Advanced** tab of the **Properties** dialog.

The **Edit User** dialog:

![Edit User dialog](image)

- **User**: the name (login) of the user.
- **Password**: the password. It can contain any symbols. The password is case-sensitive.
- **Confirm password**: enter the password here to confirm it.
Find/Replace

This dialog allows you to search for and replace text in ConceptDraw shapes. The search can be performed either in the current document, or in the documents on disk (including folders and sub folders). You can edit the document without closing this dialog - it remains floating over the document, and you can always return to it and search for the next match.

You can call the dialog from the Home tab button or by using the keyboard: Ctrl + F

Find/Replace dialog

Find what - here you can specify the string to be found. You can either type the text, or select one of the previously searched strings.
Replace with - a string with which the found string will be replaced.
Match Whole Word - search only complete words. For instance, if "leg" is being searched, the "leg" world will be found, and "legion" and "legend" will be ignored.
Match Case - specifies whether to differentiate capital and small letters in the search.
Search All Pages - specifies whether to search on the current page, or on all pages of the document. By default only the current page is searched.
Search Backwards - searches in reverse direction.
Search Linked - specifies whether to search in the hyperlinked pages and objects.
In Folder - search in all ConceptDraw located in the folder, specified in Path. All open documents that are not in the Path folder are ignored.
Path - specifies the path to the folder, where the search will be performed. You can type it manually, or choose by using the Browse button.
Look In Sub folders - specifies whether to search in sub folders of the folder, indicated in Path.
Find Next - finds the next match. If the match is found, the text editing mode is turned on and the found text gets highlighted. If the In Folder or Search Linked options are enabled, and a match is found in one of the non-opened documents, the document will be opened automatically.
Replace - replaces the found string with the string in Replace with.
Replace All - replaces all matches with the string in Replace with.
Flash Export Settings

This dialog is used to configure the parameters of the resulting .swf file when exporting the document to Macro media Flash format.

This dialog is called from the menu File / Export / Adobe Flash, or from the Share tab.

Flash Export Settings dialog

The Slide Show setting specifies when the next page of a multi-page document will be displayed:

None - only the first page is displayed.
Mouse Click - the next page will be displayed on a mouse-click.
Timer - the next page will be displayed in the specified time interval (in seconds).

Use Navigation Buttons the following navigation buttons will be inserted into the Flash file:
  - Go to first page
  - Go to previous page
  - Go to next page
  - Go to last page
Grid&Rulers

This dialog is used to configure the view of the grid and the rulers.

This dialog can be called from the Grid&Rulers button on the Document menu... menu or with the keyboard: Ctrl + Shift + G

Grid & Rulers dialog

The Rulers Origins - sets the starting point (origin) for the rulers. The origin represents the horizontal and vertical offset relative to the upper left corner of the page.
   Horizontal - horizontal offset. The possible range is -320 mm to +320 mm.
   Vertical - vertical offset. The possible range is -320 mm to +320 mm.

The Grid Origins - sets the starting point (origin) for the grid lines. The origin represents the horizontal and vertical offset relative to the upper left corner of the page.
   Horizontal - horizontal offset. The possible range is -320 mm to +320 mm.
   Vertical - vertical offset. The possible range is -320 mm to +320 mm.

The Grid Spacing section specifies the size of the grid cells.
   Horizontal - sets the width of the grid cells:
      Normal
      Fine
      Coarse
      Fixed.
   The Fixed option allows to input a custom value within the 0 mm to 320 mm range.
Vertical - sets the height of the grid cells:

- Normal
- Fine
- Coarse
- Fixed

The Fixed option allows to input a custom value within the 0 mm to 320 mm range.
The Grid Color section specifies the grid color and alpha channel settings of the grid.
The alpha channel controls the transparency/opacity of a grid color.
The maximum opacity:

The maximum transparency:
HTML Export Wizard

This dialog is used to set exporting parameters for HTML.

Access dialog from the Export item in the File menu

There is a gallery of templates in the top part of the dialog. To choose a template make a click on its icon. To export the current document with the default settings make a double-click on chosen template icon.

Process linked ConceptDraw documents - process all linked ConceptDraw documents like the current document, so you will be able to open them as regular HTML files from the exported HTML file.
Export current page only - exports only current page of the document.
Export pages as image - exports the content of ConceptDraw document as *.png image inserted into html page
Open exported page - opens exported HTML file after export using default Web-browser.
Image Properties

This dialog is used to configure export settings of ConceptDraw shapes to other graphic formats.

This dialog can be called from the File / Export / Graphic File menu, or from Share tab.

Image Properties dialog

In the Image Size section, you can choose one of these options:

- **Original size** - the shapes will be exported in their original size, regardless of the current zoom level.
- **Use zoom** - the shapes in the graphic file will be of the same size as they appear on screen (at the current zoom level).
- **Fit to size (pixels)** - this option lets you assign custom dimensions to the picture - specify the width and height in pixels.
- **High quality** - choosing this option, you'll get the best quality image. Please note, that the size of the file would increase. We recommend to use the option for printing.

In the Export section, you specify which shapes will form the image in the graphic file:

- **Whole page** - to export the entire page with all the shapes which are within the page.
- **All objects on page** - all the shapes which are on the page and outside it. The image size will be large enough to fit for all shapes.
- **Selected objects** - only the selected shapes from the active page. The image size will be equal to the total bound of all selected shapes.
- **Quality** - for JPEG format you can also specify image quality: by using the slide bar, you can set the quality within the range of 1% to 100%. Note that better quality increases the file size.
Insert Table Sections

This dialog is used to insert new sections in the Shape Parameter table.

In the dialog you can choose which sections are to be added in the table:

- **Geometry** - adds a new Geometry section. It's available for all shapes except groups.
- **Control handles** - adds the Controls section, that describes control handles. A shape can have just one Controls section.
- **Connection points** - adds the Connection Points section, that describes connection points. A shape can have just one Connection Points section.
- **Variables** - adds the Variables section, that describes user-defined variables. A shape can have just one Variables section.
- **Actions** - adds the Actions section, that describes user-defined actions. A shape can have just one Actions section. The first 15 actions are available from the shape's context menu.
- **Custom Properties** - adds the Custom Properties section, that describes user-defined data. A shape can have just one Custom Properties section.
- **Text** - adds the Text section, that describes the text properties. A shape can have just one Text section.
- **Data Sources** - adds the Data Sources section, that describes the three-side data sources properties. A shape can have just one Data Sources section.
- **Data** - adds the Data section, that describes the Data properties. A shape can have just one Data section.
- **Rapid Draw Object** - adds the Rapid Draw section, that describes the Rapid Draw properties. A shape can have just one Text section.
Library Item Properties

This dialog is used to view and set the properties of library shapes. You can call this dialog by clicking Properties in context menu of Library object in the Library window.

The Library Item Properties dialog:

- **Name** - contains the name of the library shape.
- **Prompt** - contains a brief description of the library shape.
- **Keywords** - contains comma separated keywords - words or phrases that can be used when searching the library object.

These properties are displayed when you position the mouse pointer over a shape in the library. The Item name appears as a tip over the shape, and the Item prompt is shown in the status bar.
Library Properties

This dialog is used to view and set library properties. You can call this dialog from File / Library / Properties or from the context menu in the library window.

The Library Properties dialog:

Title - the name of the library.
Keywords - contains comma separated keywords - words or phrases that can be used when searching the library.
Author and Company - information about the creators of the library.
Description - Short description of the library content.
**Page Properties**

This dialog is used to view and the page properties.

You can call this dialog from the Page Navigator menu (View tab/ Panels/Pages)

The *Page Properties* dialog:

![Page Properties dialog](image)

*Title* - the name of the Page

*Description* - Short description of the page content.
Login

This dialog asks user login and password for documents with protected access.

This dialog appears when you try to open a protected document. If such user name and password are not authorized to view the document, the document is not opened.

The *Login* dialog:

![Login dialog](image)

*User* - the name (login) of the user.

*Password* - password.

*Note:* To protect the document and specify authorized users, use the [Properties](#) dialog, the *Advanced* tab.
Open

This dialog is used to open ConceptDraw documents and to import documents of supported formats. The
dialog can be called from the File / Open menu, or by using the keyboard: Ctrl + O. The dialog is also
called when importing files.

Open dialog

In this dialog you can choose to show only files of the desired type.

In the list, choose the document you want to open, and double-click it with the mouse. To select more
than one document, hold down the Shift or Ctrl keys.

Open - opens selected documents.

Cancel - closes the dialog.

Note: By default, this dialog shows only ConceptDraw PRO files. To show files of other types, choose
the corresponding type in the drop-down list.
Paste Special

This dialog is used to insert various objects from the Clipboard into a ConceptDraw document.

This dialog can be called from the Home/ Paste Special menu.

The Paste Special dialog:

Source - indicates from where the object was copied.

As - offers available formats in which the object can be pasted. Depends on the current buffer content.

Paste - the object will be embedded into the ConceptDraw document and will be stored together with it.

Paste Link - pastes a reference to the object, rather than the object itself. When the source file is changed, the object in the ConceptDraw document will be changed respectively. Only a link to the object is stored with the document.

Result - explains what will happen when you insert the object in the selected format.

Display As Icon - specifies whether the object should be displayed as icon, or in its original form.

Result - explains what will happen when you insert the object in the selected format.
Options

This dialog controls the application settings. To call the dialog, choose **Options** from the **File** menu. The dialog contains several tabs, where various settings are grouped:

- **General** - contains the default settings for new documents,
- **View** - determines the appearance of some components of the application,
- **Save** - contains the saving parameters of the documents,
- **Advanced** - describes scripting and ConceptDraw Basic Editor settings,
- **Spelling** - contains the saving parameters of the documents,

**Default** tab

This tab describes the parameters of the documents, created with the **New** command. You can choose whether to base a new document on the default settings or on a default template file:

- **New Document with Start Template** - allows to choose a template file, on which every new document will be based. Use the Browse button to choose the file, or specify the path in the edit field.

- **New Document with Default Settings** - indicates, that the document is created with the default parameters, listed below:

  - **Page size** setting determines the size of the document page. You can choose between:
    - **Pre-defined** - allows to select a size from the list.
    - **Custom** - specified by the user.

  - **Units of measure** - choose the units of measure from the list.
  - **Display angles in** - choose whether to display angles in degrees or in radians.
The *Undo and Snap* section controls the Undo/Redo and Snap settings.

*Undo depth* - specifies the number of consecutive actions you can undo. The default value is 30. Making it much higher takes a lot of memory and can slow down the program.

*Snap sensitivity* - sets the distance from which snapping and gluing are activated. This distance is set in pixels and does not depend on the scale or magnification. The default value is 15 pixels.

*Use local units* - depending on this setting the program will set print paper size and document page size.

1. Use local units checked (default option):
   - For A4 or letter sizes print paper size will be set to your local common size (for example, letter for USA) and page size will be set to the same as printer paper size.
   - For custom sizes print paper size will be set to your local common size and page size will be set to the custom size you set.

2. Use local units blanked:
   - For A4 or letter sizes print paper size will be set respectively to A4 or letter and page size will be set to the same as printer paper size.
   - For custom sizes which are supported by your default printer, the print paper size will be set to the custom size you set and page size will be set to the same as printer paper size.
   - For custom sizes which are not supported by your default printer, the print paper size will be set to your local common size (for example, letter for USA) and page size will be set to the custom size you set.
**View tab**

- **Options** section determines how text and hyperlinks are displayed in the program:
  - **Enable auto-scrolling** - if enabled, the document will be scrolled when you position the mouse pointer over an edge of the window.
  - **Enable floating window docking** - Lets you dock floating windows as tabs when dragging one window to another.
  - **WYSIWYG font list** - If enabled, all font names will be live previewed in the font list.
  - **Mark hyperlinks to text** - turns on the hyperlink auto parsing mode.
  - **Small tool switching** - allows small tool switching.
  - **Automatically zoom under ... points when editing** - lets you adjust the text editing functionality. You can enable the auto zoom in the document if the text looks too small, and set the minimum font size acceptable for text editing mode (setting the font size best viewed).

- **Show** section contains settings for screen tips:
  - **Library window screen tips** - specifies whether to display screen tips when the mouse pointer is paused over a library shape.
  - **Shape screen tips** - specifies whether to display screen tip for shapes in a document (see the description of the Info floating dialog and the Information tab of the Shape Properties dialog).
  - **Control handle screen tips** - specifies whether to display screen tip for control handles.
  - **Show developer tab** - show/hide the Developer tab enabling ConceptDraw Basic Script editing.
Save Options section describes the auto-save parameters of the application.

Save AutoBackup every ... minutes - saves a backup copy of the document automatically after the specified time interval.

Note: if you're working with large multi-page documents, don't specify a very small interval as it may slow down working.

The Format Options section contains the parameters that set the default format of the document.

By default save file as - sets the format in which new documents will be saved.

Save workspace with document - if this parameter is enabled, the document stores the arrangement of open windows, libraries, etc. This arrangement is restored when you open the document.
**Advanced tab**

The **Scripting Settings** section sets how ConceptDraw Basic scripts will be treated by ConceptDraw:

- **Allow to run ConceptDraw Basic automatically** - allows the program to run scripts automatically.
- **Allow editing ConceptDraw Basic scripts** - allows to edit scripts.

The **CD Basic Editor Window** specifies how the CD Basic Editor window looks. You can choose the font and font size, and preview them in the area below:

- **Font** - select a font from the list,
- **Size** - select a font size from the list.
Spell Check tab

Put a tick in front of the languages you use in your document for correct spell check.
Save

This dialog is used to save documents, templates, workspace files and files of other formats, exported by ConceptDraw. This dialog can be called from the File menu by the Save (Ctrl + S) item (if you save the file for the first time), Save As (Ctrl + Shift + S), Save As Template, commands or by using the keyboard. This dialog is also called when you export files (see the Exporting a Document section in the Manual).

Save dialog

Depending on the command you use to call the dialog, you get different save options. When you use the Save and Save As commands, you can save in one of the following formats:

- CDDZ (ConceptDraw Document)
- CDD (ConceptDraw Document v7-9)
- CDS (ConceptDraw Presentation)
- CDT (ConceptDraw Template)

If you use the Save As Template... command, you'll be able to save a template file respectively. To save files in other formats, use the File / Export menu.

Save - saves the document.
Cancel - closes the dialog.
Shape Properties

This dialog is used to modify properties of a shape. You can call this dialog from the Shape tab, from the context menu or by using the keyboard: Ctrl + Shift + C

The dialog includes the following tabs:

- **Information** - contains basic information about the selected shape.
- **Behavior & DoubleClick** - determines how the shape interacts with other shapes, allows to protect some parameters from changing. Also it allows to assign an action that is performed when the shape is double-clicked.
- **Lock** - allows to protect some properties of the shape from changing.

**Information tab**

When more than one shape is selected, it displays information for the primary selected shape.

- **ID** - indicates the unique number of the shape in the current document.
- **Sub ID** - indicates the number of the shape in its parent group. It's used for referring to shapes inside a group.
- **Name** - in this field you can type the name you want to assign to the shape.
- **Layer** - assigns the shape to a layer.
- **Description** - here is the short description of the object and the name of its parent library
- **Keywords** - in this field you can enter the keywords which the search engines will use to include the given shape in their search results.
Behavior & Protection tab

Interaction Style section determines whether the shape is a connector or not, and lets you turn any shape into a connector if necessary:

- **Line(1-D)** - the shape behaves as a line - it has a begin and end point (is a 1D-shape). Such shape can be used as a connector.
- **Box(2-D)** - the shape behaves as a 2D-shape, that is, it has width and height.

Selection Highlighting section describes how the shape is displayed when selected. The following options are available:

- **Show shape handles** - display or hide the handles on the shape's alignment box. This option is on by default.
- **Show control handles** - display or hide the control handles of the shape. This option is on by default.
- **Show alignment box** - display or hide the shape's alignment box. This option is on by default.

Resize Behavior section describes how the shape behaves within a group when the group is resized:

- **Scale with group** - always resize the shape as the group is resized. This option is set by default.
- **Reposition only** - simply move the shape without changing its size.
- **Use group's settings** - the shape uses the behavior settings of the group to which it belongs.
- **Save original scale** - if this option is on, the shape will keep its size when inserted into a document with some other scale. Otherwise, the size of the shape will be changed according to the scale settings of that document.
Group Behavior section describes how the group behaves:

- **Enable group's text** - allows the group to have its own text.
- **Select group only** - sets whether you can select shapes inside the group.
- **Reverse selection** - changes the order of selecting a group and objects within a group (by default, the first click selects the group and, the second - the object).

Only works if item "select group only" is toggled off.

The Double Click section specifies the action, performed when the shape is double-clicked:

- **Perform no action** - nothing happens.
- **Edit shape's text** - turn on the text editing mode.
- **Edit shape's table** - display the shape parameter table.
- **Edit group in new window** - open the Edit Group window, where you can edit the shapes inside the group (this option is only available for groups).
- **Go to hyperlink** - open the hyperlink (available if the shape has a hyperlink).

**Action** - perform a user-defined action. Two modes are available: you can choose an action from the list, or choose.
The Lock section allows to protect some properties of the shape from changing.

*Fill* - lock the fill options changing.
*Line* - lock line changing.
*Width* - locks/unlocks the shape's width against resizing.
*Height* - locks/unlocks the shape's height against resizing.
*X position* - locks/unlocks the horizontal (X) position of the shape.
*Y position* - locks/unlocks the vertical (Y) position of the shape.
*Aspect ratio* - if on, the ratio between the width and height is always preserved when the shape is resized.
*Begin point* - for 1D shapes, locks/unlocks the begin point against repositioning.
*End point* - for 1D shapes, locks/unlocks the end point against repositioning.
*Rotation* - locks/unlocks the shape against rotation.
*Vertex* - locks/unlocks the shape against applying of the Edit Vertex tool.
*Flip X* locks/unlocks the shape against flipping horizontally.
*Flip Y* locks/unlocks the shape against flipping vertically.
*Deletion* - locks/unlocks the shape or its vertices against deleting.
>Show text* - sets whether to display the shape's text.
*Don't print* - sets whether the shape can be printed.
Snap and Glue Settings

This dialog is used to configure the snapping and gluing settings. You can call this dialog from the Document / Snap & Glue button or by using the keyboard: Ctrl + Shift + U

If Snap to is enabled, you can specify the conditions when snapping will be activated:

- Objects - the shape will snap to the closest objects using dynamic guides as shown in the picture below.

- Ruler Subdivisions - the shape will snap to the imaginary lines coming out of the rulers' subdivisions. Use this for very precise positioning.
- Grid - the shape will snap to the grid nodes.
- Guides - the shape will snap to the guide lines.
- Geometry - the shape will snap to the outlines of other shape. It is usually helpful when you need to attach a shape to another shape.
- Shape Handles - the shape will snap to resize handles of other shapes.
- Vertices - the shape will snap to vertices of other shapes.
- Angles - Snap to dynamic guides during rotation of object to a multiple of 45 degrees.
- Connections Points - the shape will snap to connection points of other shapes.
- Glue to Guides - allows shapes to glue to guide lines.

Snap sensitivity (the distance from which snapping is activated) can be set in the Document Properties dialog, the Settings tab.
Spell Check

You can use the **Spell Check** dialog to find mistakes in the shapes text. You can call this dialog using the spelling button [ ] on the **Home** tab.

When you call the dialog, the Spell Check engine checks all objects in your document at all pages. You will see the results of the check in the next dialog.

The mistakes are marked red and underlined. You can select one of the words from the internal dictionary and correct a mistake by pressing the **Change** button, ignore a mistake by pressing the **Ignore** button, ignore all mistakes by pressing **Ignore All** button, or add a word to the **User Dictionary** by pressing the **Add** button. To change an existing word you need to select it, correct it and press the **Change** button. You can also delete words from the **User Dictionary**. To delete a word you need to select it and press the **Delete** button.
Template Setup

Here you can set the print settings for the document, and select the size and orientation of pages in the current document as well as in all further new documents.

Here you can set measurement units and scale. The grid and snap options can be also set here. All settings will may by applied to the current document as well as to all further new documents.
Text Properties

You can use the Text Properties dialog to set or modify various attributes of the shape's text. You can call this dialog from the context menu of the selected object, or by using the keyboard: Ctrl + Shift + T.

When you call the dialog, three situations are possible:
1. One of the shapes is in the text editing mode - the all changes will be applied to the selected text in the shape.
2. One or more shapes are selected - the changes will be applied to the whole text of the selected shapes.
3. None of the shapes is selected - the changes are applied to default settings for new shapes.

The Text Properties dialog contains the following tabs:
- **Font** - specifies the font, font style and other attributes,
- **Paragraph** - specifies various paragraph properties. The end of a paragraph is denoted by the linefeed character (inserted with the Return (Enter) key),
- **TextBlock** - sets text block parameters of the shape,
- **Tabs** - allows to add, delete or modify tab stops.

**Font** tab:

Font - allows you to choose a font from the list of installed fonts.
Language - sets the language (encoding) for characters. It's required to exchange documents with applications which don't support Unicode, and with ConceptDraw 1.x.
Size - specifies the font size in points. 1 point = 1/72 inch.
Color - sets the text color. You can choose a color from the color palette, or set a custom color.
Spacing - specifies how much to increase or decrease the distance between characters (in points). Enter 0 for normal spacing, a positive number - to increase spacing, a negative number - to decrease spacing.
The Styles allows to apply one of the following styles to font: Bold, Italic, Underline, Strikethrough, Superscript, Subscript.
The *Horizontal Alignment* section describes how the paragraph is aligned relative to the shape's text box. The following alignment types are available:

- **Left** - to the left side of the text box,
- **Centered** - the lines are justified with respect to the center of the text box,
- **Right** - to the right side of the text box.

The *Indentation* section allows to set indents for the paragraph in millimeters or inches (depending on the measurement system of the document).

- **First Line** - specifies the indent for the first line of the paragraph,
- **From Left** - specifies the left indent for all lines of the paragraph,
- **From Right** - specifies the right indent for all lines of the paragraph.

In the *Spacing* section you can set the distance between the lines of text. The distance is specified in points (though you can use other units of measure too). A positive value increases the distance, a negative value - decreases the distance.

- **Before** - changes the spacing between the current and the previous paragraphs,
- **After** - changes the spacing between the current and the next paragraphs,
- **Line** - changes the distance between the lines for all selected paragraphs. When you set the value in percent (120%, 150%, etc) the spacing will be based on the font size. Also, you can set a fixed value in points. The default value is 100%.
The **TextBlock** tab

![Text Properties](image)

The **Vertical alignment** section determines how the text block is positioned relative to the shape's text box:

- **Top** - moves the text to the top of the text box,
- **Middle** - centers the text in the middle of the text box,
- **Bottom** - moves the text to the bottom of the text box.

The **Margins** section describes margins for the text block (the margins are specified in millimeters or inches depending on the measurement system of the document).

- **Left** - specifies the left margin for the text block,
- **Right** - specifies the right margin for the text block,
- **Top** - specifies the top margin for the text block,
- **Bottom** - specifies the bottom margin for the text block.

**Text Background** allows to choose a background color for the text. **Transparent** sets transparent background for the text (this option is on by default).
**Tabs** tab

The **Tabs** table contains the list of current tab stop positions. The left column shows the tab position, the right one specifies the alignment type with respect to the position. The **Tab Stop Position** area allows to modify the tab position, selected in the **Tabs** table. The **Default Tab Stop** - specifies the default tab position for the entire shape. By default, it's 1/2 inch.

The **Alignment** section specifies how text is aligned with respect to the tab position:
- **Left** - places the left edge of the text in the specified position,
- **Center** - places the center of the text in the specified position,
- **Right** - places the right edge of the text in the specified position,
- **Decimal(.)** - if there's the point separator (.) in the text, the text is aligned by the point.
- **Comma(,)** - if there's the comma separator (,) in the text, the text is aligned by the comma.

The picture below demonstrates possible types of alignment:

<table>
<thead>
<tr>
<th>Left</th>
<th>Center</th>
<th>Right</th>
<th>Decimal</th>
<th>Comma</th>
</tr>
</thead>
<tbody>
<tr>
<td>Left</td>
<td>Center</td>
<td>Right</td>
<td>123.45</td>
<td>123.46</td>
</tr>
<tr>
<td>Left1</td>
<td>Center1</td>
<td>Right1</td>
<td>12311.4511</td>
<td>1231.451</td>
</tr>
<tr>
<td>Left22</td>
<td>Center22</td>
<td>Right22</td>
<td>124522</td>
<td>124522</td>
</tr>
</tbody>
</table>

Tab stop positions are shown with red lines.

**Add** - adds to the **Tabs** list the tab stop described in **Tab Stop Position**. For convenience, after you click the **Add** button, the setting in the **Tab Stop Position** area is increased by the value of **Default Tab Stop**.

**Modify** - replaces the settings of the tab stop selected in the **Tabs** list with the settings, displayed in the **Tab Stop Position** field and in the **Alignment** section.

**Remove** - removes the tab stop position selected in the list.

**Remove All** - removes all tab stops from the list.
View Sections

This dialog is used to display or hide existing sections of the Shape Parameter table. If the corresponding option is enabled, the section is visible, otherwise - it is hidden. View Sections dialog:

- **Object Transform** - display/hide the Transform section.
- **Geometry** - display/hide the Geometry section.
- **Line Format** - display/hide the Line Properties section.
- **Fill Format** - display/hide the Fill Format section.
- **Protection** - display/hide the Protection section.
- **Miscellaneous** - display/hide the Miscellaneous section.
- **Connection Points** - display/hide the Connection Points section.
- **Control Handles** - display/hide the Control Handles section.
- **Variables** - display/hide the Variables section.
- **Text Transform** - display/hide the Text Transform section.
- **Character Format** - display/hide the Character Format section.
- **Paragraph Format** - display/hide the Paragraph Format section.
- **Text Block Format** - display/hide the Text Block Format section.
- **Text Tab Stops** - display/hide the Text Tab Stops section.
- **Text Fields** - display/hide the Text Fields section.
- **Actions** - display/hide the Actions section.
- **Custom Properties** - display/hide the Custom Properties section.
- **End Points** - display/hide the End Points section (available for 1D shapes and connectors only).
- **Glue Info** - display/hide the Glue Info section (available for 1D shapes and connectors only).
- **Data Sources** - display/hide the Data Sources section.
- **Data** - display/hide the Data section.
- **Rapid Draw Object** - display/hide the Rapid Draw Object section.
Floating Panels

Some tools and features in ConceptDraw PRO are accessible from the floating panels. You may find here particular tools and resources that you might need while working with graphic documents.
You can call the dialog from the View tab by clicking the Libraries button or using the Panels list.
Wide collections of shapes and Clip arts help you create a different types of diagrams, as well as various sorts of technical drawings.
1. **Libraries section** displays the opened libraries. You can cause a list of opened libraries by using the drop-down button. Press the navigation arrows ← → to navigate through libraries.

You can manage the libraries using the context menu and **Library Properties** Dialog.
2. **Objects section** displays objects containing in the active library.

There are a few different methods for placing an object into your drawing:
- Click on an object and then click on the document, at the place you want the object to be inserted.
- Perform a drag-and-drop from the library to your document.
- Double click on an object’s icon in the library to place an object in the center of your document.

You can manage library objects using the context menu and Library Item Properties dialog:

Some of ConceptDraw libraries contain objects, identified by a blue tile in the library preview. Such objects can be edited by using the Action button menu. To open the menu select an object and click the action button in the upper right corner of the object.
Some ConceptDraw PRO objects are assigned Rapid Draw features. Rapid Draw allows you to build diagram quickly. Select a Rapid Draw featured object.

You can add the next object by clicking on its icon from the Rapid Draw arrows that pop up when you bring the mouse cursor over the object.

Rapid Draw will automatically draw and connect the next object in your drawing.
Solutions

ConceptDraw PRO provides an access to an online service that delivers additional product extensions. This is a time saving assistant for generating business documents and presentations. ConceptDraw Solution Park is an online collection of visual solutions for ConceptDraw products. It contains many subject areas for professional applications. Solutions panel provides the list of available solutions in alphabetical order. Access the panel from the Home tab, or using the Panels list at the View tab.

1. Search window. You can search for library objects. Enter a keyword or an object name in the search field. The object will be found and displayed in the Library panel.

2. Search in ConceptDraw Store. You can run the ConceptDraw Store application to search for the the proper solution in Solution Park.
3. **Solution section.** This section contains the list of available solutions in alphabetical order. Use the drop-down button to preview Libraries, Templates and Samples contained in the certain solution. You can open them by click.

![Solutions section](image)

- **Area Charts**
- **Libraries**
- **Templates**
- **Samples**
Pages

Access the panel from the Panels list at the View tab. Work with pages of a current document.

The active page preview. Double-click name to rename page.

Page has background

Page is assigned to be background page
You can operate pages using the context menu. Access it from the button.

**Add Page** - add a blank page at the end of the document
**Insert Page** - add a blank page below the selected page
**Duplicate page** - duplicate the selected page
**Rename Page** - rename the selected page
**Choose Background** - assign a background for the selected page from a list of all document's pages. By default, the new page has no background

**Set as Background for** - set the selected page as a background to other pages. By default, the new page is not a background page

**Remove Page** - remove page from the document
**View as** - change the page preview appearance

**Adjust to Drawing Content** - resize page to fit a content
**Properties** - open the Page Properties dialog
Layers

You can call the dialog from the View tab by clicking the Layers button or using the Panels list.
Dialog shows layers and allows changing of properties.

<table>
<thead>
<tr>
<th>Layer 1</th>
<th>Layer's Name</th>
<th>Double-Click to rename</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Visible (Invisible)</td>
<td>On/Off Layer visibility</td>
</tr>
<tr>
<td></td>
<td>Unlocked (Locked)</td>
<td>Enable/Disable editing Layer</td>
</tr>
<tr>
<td></td>
<td>Printable</td>
<td>Enable/Disable printing objects of Layer</td>
</tr>
<tr>
<td></td>
<td>Layer's Color</td>
<td>Change the Line Color of all objects on Layer</td>
</tr>
<tr>
<td></td>
<td></td>
<td>On/Off color changes with check</td>
</tr>
</tbody>
</table>

Layer 1 is the Active Layer. You can change any properties of this Layer:
- Add Layer
- Add new Layer
- Delete Layer
- Delete the current Layer

Select Objects on Layer: Select all objects on current Layer
Floating Panels

Arrange

ConceptDraw PRO provides tools to help ensure the shapes in your diagram are aligned and spaced well. That helps make your drawing as clear as possible and give it a professional look. Access the Arrange panel from the Home tab, or using the Panels list at the View tab.

- **Order**
  Here are object order tools. They help you control the placement of overlapping objects.

- **Align and Distribute**
  Align shapes without changing their spacing using the Left, Central, Right controls to set a horizontal alignment and Top, Middle and Bottom controls to set a vertical alignment.
  Distribute the space between object's control frames using the Vertical and Horizontal distribution.

- **Size**
  Set the size of the object in the units specified in the Options.

- **Position**
  Set the position of the object in the coordinate system.

- **Rotate and Flip**
  You can rotate objects rotated clockwise and counterclockwise in 90 and 180 degrees. You can flip them vertically, flip them horizontally, or rotate using the Angle and Pin.

- **Group and Lock**
  You can group Group and Ungroup selected objects. The Edit group button allows you to change objects within group using a special window for edits.

- **Make Same**
  You can make the certain properties of selected objects identical.
Format

ConceptDraw PRO provides tools to help ensure the selected objects in your diagram are aligned and spaced well. That helps make your drawing as clear as possible and give it a professional look. Access the Format panel from the Home tab, or using the Panels list at the View tab. Format panel has different appearance depending on the object selected.

Format panel for a Library object

- **Fill**
  Change the fill color of selected object.

- **Border**
  Change line color and line pattern.

- **Shadow**
  Select shadow style and color.

- **Make Same Attributes**
  Make certain properties of selected objects identical.
Format panel for a Connector

- **Connector Type**
  Change the *type of connector*.

- **Stroke**
  Change the type of the stroke of the selected connector.

- **End Points**
  Change the form and size of the arrowheads of the selected connectors.

- **Make Same Attributes**
  Make certain properties of selected objects identical.
Hypernote

Use this panel to assign text notes and hyperlinks. You can add hyperlinks to any ConceptDraw object. The hyperlinks can link to another page or object in the current document, or a Web site. Access the panel from the Panels list at the View tab or from context menu of the object.

Hypernote dialog

- **Title**
  Click to enter the Title of Hypernote

- **Hypernote**
  Click to enter text Notes.

- **Hyperlinks**
  Click to add a hyperlink using the Set Hyperlink dialog.
  You can edit hyperlinks using context menu.
Set Hyperlink

Hyperlinks can be of the following types: a hyperlink to an Internet **address**, files, or to a **page/object** in the current document.

**Link to Web** - you can add one or more hyperlinks to an Internet address. When such link is opened, the program launches the default browser and goes to that address. You can type the hyperlink address manually, or and copy and paste the link from the Internet browser.

**Link to FILE** - you can add a hyperlink to other files on your computer or the ones accessed from your local network.

**Link to this document** - allows adding hyperlink to another page or shape in the current document.

**Go to Link** - allows to go to the hyperlink without closing the dialog.

You can assign hyperlinks to the shape's text as well. This can only be done in the text editing mode. To open this dialog from the context menu make a right mouse click on the selected text.

The link will be assigned to the selected words/characters.
Presentation

Use Presentation panel to operate ConceptDraw PRO dynamic presentations. Access the panel from the Panels list at the View tab.

- **Slideshow**
  Operate slideshow using these command buttons. You can play a slide presentation of the current document. Slides will be created from document's pages. Hover the mouse over the bottom of the screen to access the presentation control panel.

- **Options**
  Set the consecutive order of Slide Show.
  Change document size to fit monitor resolution. ConceptDraw PRO supports multi-monitor usage. The only limit is that ConceptDraw PRO can run only one presentation at a time. So, you can run a presentation in one monitor and have the same or a different document open for editing on the second monitor. By default every presentation is displayed on the primary monitor. To run a presentation on the secondary monitor select the monitor from Output Device drop-down list.
Info

You can call the dialog from the View tab by clicking the Info button or using the Panels list.
Shows the information about selected object. (If several objects are selected, the dialog shows the information about object, selected first).

- **Meta Data**
  Contains meta data related to an object: name, description including name of the parent library and keywords that will help to search this object.

- **Developer Info**
  Contains: ID - the unique identification number of the object within current document;
  Sub ID - the unique identification number of the object within current group;
  Layer - number of Layer where object is located.
Custom Properties

This dialog is used to view and edit user-defined data of shapes. You can call the dialog from the Shape menu by clicking the Custom Properties button or using the Panels list at the View tab, or from the context menu in the document window. Prior to calling the dialog, select the shape which properties you're going to view or edit. If there are several selected shapes, the properties will be shown for the shape with primary selection (the one that displays green handles).

If the shape has no custom properties, you'll be offered to Add Custom Properties and the Define Custom Properties dialog will be opened.
The upper part of the dialog displays the list of custom properties of the shape. The list contains the names of the properties (the Label field in the Define Custom Properties dialog) and the values of the properties (the Value field in the Define Custom Properties dialog). Depending on the value format, the value field may be either an input field, or a drop down list. Prompt - displays the tip for the property (if it was defined in the Prompt field of the Define Custom Properties dialog). Add Custom Properties... - calls the Define Custom Properties dialog where you can edit the existing properties, or add new ones.
Advanced

Access the panel from the Panels list at the View tab. Edit object behavior, protection, and double-click properties

- **Lock**  
  Define parameters of an object that should be locked from changes

- **Behavior on Double Click**  
  Define Double-Click actions:  
  - *Perform no action* - No actions on Double-Click;  
  - *Edit text* - Edit a text of an Object;  
  - *Power Edit Table* - Edit Shape Parameter Table;  
  - *Edit group* - Open a new window for grouped objects editing;  
  - *Go to Hyperlink* - Open hyperlink;  
  - *Action* - Choose one actions, assigned to object. The assigned action will be performed continuously with Double-Click.

- **Miscellaneous**  
  - *2D Shape* - Changes object's height and width;  
  - *Connector* - Changes line height. Line can be connected to another with connecting points (the same as connector). Object can be connected to another with connecting points (the same as connector);  
  You can set the view of selected objects using check boxes: Shape Handles, Control Handles, Alignment Box.  
  You can set properties for grouped objects during group resizing.  
  - *Scale with Group* - All objects scale similarly and simultaneously around group center;  
  - *Reposition only* - Group resizing will move grouped objects without resizing;  
  - *Inherit Group Settings* - Apply the entire group settings while resizing individual objects from this group;  
  - *Group text* - Enable/Disable object text editing in group;  
  - *Select group only* - Enable/Disable selecting individual objects within a group. Reverse Selection controls will change the order of selection between object and group  
  - *Select Group first* - Click on the object to select the entire group, the next click will select this object within group.  
  - *Select Child First* - Click on the object to select it within group, the next click will select the entire group.
Colors

Colors panel is a horizontal bar at the bottom of a document window. Access the panel from the Panels list at the View tab. Colors panel provides quick access to manage the color of fill, line and text of the selected object. Switching between controls is done by clicking on the left edge of the panel.

Fill

Line

Text
Context Menu

ConceptDraw PRO enables access the most frequently used operations with objects via the context menu. There are different types of context menu related to different pieces selected. The figure below displays all the types of context menus. However, actually, you can see only one menu - depending on the selected item.

1 - Library Context menu
2 - Library object Context Menu
3 - Object Context Menu
4 - Text Context Menu
Library Context Menu

ConceptDraw PRO enables manage libraries using context menu.

- **New** - create a new empty library.
- **Open** - Open an existing library using the **Open** dialog.
- **Save** - Save changes in the existing library using the **Save As** dialog.
- **Save as** - Save a new library using the **Save As** dialog.
- **Send via E-mail** - Send a copy of the file in an e-mail as an attachment.

**Note**: The default location of the saved libraries: C:Users\UserName\Documents\My ConceptDraw.
Add Section - You can create sections in libraries. Each section is placed in the drop-down list. So you can easily manage the content of large libraries. Sections can be easily managed using context menu.

Show file location - Show where the library is stored on the disk
Show in Solutions - Highlight the Library in the Solutions panel
Properties - Open the Library Properties dialog

You can change the Library items appearance:

View as Icons

View as Icons and Text

View as Icons and Text Right
Library Object Context Menu

ConceptDraw PRO enables manage library items using context menu.

Add section - Add a new section to the current library
Cut, Copy, Paste, Delete - you can perform the common operations with library items
Replace - Replace the selected library object with the object selected on a drawing page.
Change icon - You can replace the object icon with any graphic image using the Open dialog.

Move to Section - You can move objects between libraries sections.
Properties - open the Library Item Properties dialog.
View options enables changing Library items appearance.
Object Context Menu

ConceptDraw PRO allows you to access the most frequently used operations with objects via the context menu.

Cut, Copy, Paste, Delete - you can perform the common operations with an object.
Substitute - You can change the selected object by another.
Shape Properties - Open the Shape Properties Dialog.
Text Format - Open the Text Properties dialog
Fit to Text - Make the sizes of object appropriate to the text size.

Object - Provide quick access to some options commonly managed from the Arrange panel. Also enables select the object's text for further editing.

Hypernote - Activate the Hypernote panel.
Lock - Provides quick access to Lock options commonly managed from the Advanced panel.
Add Custom Properties - Activate the Custom Properties panel.
Text Context Menu

ConceptDraw PRO allows you to access the most frequently used operations with text via the context menu. There different ways to select a text. You can select a desired piece of text using the Text Selection Tool, or you can select the entire text using the Edit Text command from the Object context menu.

Cut, Copy, Paste, Select - you can perform the common operations with a selected text the same as with object.

Bold, italic, Underline - Provide quick access to some options commonly managed in the Home tab.

Text Format - Open the Text Properties dialog.

Hyperlink - Open the Set Hyperlink dialog.
Status Bar

The Status Bar is available at the bottom of the document window and displays information about the current window's state.

1. The Scroll Hand tool is used to scroll the document.
2. The Zoom Box tool is used to zoom in and zoom out, keeping screen focused on the selected objects.
3. Fit to Page tool is used to zoom a drawing to fit the current document window.
4. Zoom Control tool is used to set the zoom level visually by scrolling the pointer left, or right.
5. Zoom Percentage tool is used to set a zoom level in percents.
# Keyboard Shortcuts and Mouse Actions

<table>
<thead>
<tr>
<th>Keyboard / Mouse</th>
<th>Operation</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>DOCUMENT AND WINDOWS</strong></td>
<td></td>
</tr>
<tr>
<td>Ctrl + N</td>
<td>Create a new document</td>
</tr>
<tr>
<td>Ctrl + Alt + N</td>
<td>Create a new document from a template</td>
</tr>
<tr>
<td>Ctrl+Shift+open Library</td>
<td>Open an earlier saved template preview</td>
</tr>
<tr>
<td>Ctrl + O</td>
<td>Open a document/template/workspace file.</td>
</tr>
<tr>
<td>Ctrl + S</td>
<td>Save the active document</td>
</tr>
<tr>
<td>Ctrl + Shift + S</td>
<td>Save the document under a new filename</td>
</tr>
<tr>
<td>F5</td>
<td>Start Presentation</td>
</tr>
<tr>
<td>Ctrl + P</td>
<td>Print the active document</td>
</tr>
<tr>
<td>Ctrl + Alt + P</td>
<td>Print Preview</td>
</tr>
<tr>
<td>Ctrl + F</td>
<td>Find and Replace</td>
</tr>
<tr>
<td>Ctrl + Shift + G</td>
<td>Set Grid properties for the active document</td>
</tr>
<tr>
<td>Ctrl + Shift + U</td>
<td>Set Snap&amp;Glue options f</td>
</tr>
<tr>
<td>Ctrl + W</td>
<td>Close the active window</td>
</tr>
<tr>
<td>Ctrl + Tab</td>
<td>Activate the next window</td>
</tr>
<tr>
<td>F3</td>
<td>Open Shape Parameter Table</td>
</tr>
<tr>
<td>Alt + F4, Ctrl + Q</td>
<td>Quit ConceptDraw PRO</td>
</tr>
<tr>
<td>Ctrl + F1</td>
<td>Open About dialog</td>
</tr>
<tr>
<td><strong>VIEW</strong></td>
<td></td>
</tr>
<tr>
<td>Ctrl + “+”</td>
<td>Zoom In</td>
</tr>
<tr>
<td>Ctrl + “-“</td>
<td>Zoom Out</td>
</tr>
<tr>
<td>Ctrl + Shift + Z</td>
<td>Activate the Zoom Box mode</td>
</tr>
<tr>
<td>Click/ Click + Alt in Zoom Box</td>
<td>Zoom In/ Zoom Out</td>
</tr>
<tr>
<td>Ctrl + Shift + 0</td>
<td>Set zoom to Whole Page</td>
</tr>
<tr>
<td>Click in Print Preview</td>
<td>Change zoom level (in cycle)</td>
</tr>
</tbody>
</table>
Keyboard Shortcuts and Mouse Actions

**Keyboard Shortcuts**

- **PgUp** Scroll one window space up
- **PgDn** Scroll one window space down
- **Ctrl + Home** Go to the top-left corner of the page
- **Ctrl + End** Go to the bottom-left corner of the page
- **Ctrl + PgUp** Go to the previous page
- **Ctrl + PgDn** Go to the next page

**SELECTING SHAPES**

- **Select with Shift** Allows to select several shapes
- **Ctrl + A** Select all the shapes on page
- **Ctrl + T** Activate Text Selection Tool
- **Tab/ Shift + Tab** Select the next/ previous shape
- **Shift** Select objects without quitting the mode

**HYPERLINKS**

- **Ctrl + Shift + E** Create / Edit hyperlink
- **Ctrl + Shift + H** Open hyperlink

**EDITING**

- **Ctrl + Z** Undo the last operation
- **Ctrl + Y** Redo what was reversed by Undo
- **Ctrl + X, Shift + Del** Cut the selection to the Clipboard
- **Ctrl + C, Ctrl + Ins** Copy the selection to the Clipboard
- **Ctrl + V, Shift + Ins** Paste
- **Ctrl + Alt + V** Paste Special
- **Ctrl + Shift + V** Paste in Place
- **Del** Delete the selected shape(s)
- **Ctrl + D, Ctrl for dragging** Duplicate the selected shape(s)
- **Insert Vertex with Ctrl** Cut the line in this place
- **Ctrl in drawing** Add the new segment to the selected figure

**LIBRARIES**
<table>
<thead>
<tr>
<th>Keyboard Shortcuts and Mouse Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Ctrl + Shift + N</strong></td>
</tr>
<tr>
<td>Create a new library</td>
</tr>
<tr>
<td><strong>Ctrl + Shift + O</strong></td>
</tr>
<tr>
<td>Open a library</td>
</tr>
<tr>
<td><strong>Ctrl + Shift + I</strong></td>
</tr>
<tr>
<td>Replace the library object with page object</td>
</tr>
<tr>
<td><strong>SHAPES</strong></td>
</tr>
<tr>
<td><strong>Ctrl + Alt + B</strong></td>
</tr>
<tr>
<td>Send to Back</td>
</tr>
<tr>
<td><strong>Ctrl + Alt + F</strong></td>
</tr>
<tr>
<td>Bring to Front</td>
</tr>
<tr>
<td><strong>Ctrl + Shift + B</strong></td>
</tr>
<tr>
<td>Send Backwards</td>
</tr>
<tr>
<td><strong>Ctrl + Shift + F</strong></td>
</tr>
<tr>
<td>Bring Forward</td>
</tr>
<tr>
<td><strong>Ctrl + J</strong></td>
</tr>
<tr>
<td>Flip Vertical</td>
</tr>
<tr>
<td><strong>Ctrl + H</strong></td>
</tr>
<tr>
<td>Flip Horizontal</td>
</tr>
<tr>
<td><strong>Ctrl + L</strong></td>
</tr>
<tr>
<td>Rotate Left (90 degrees)</td>
</tr>
<tr>
<td><strong>Ctrl + R</strong></td>
</tr>
<tr>
<td>Rotate Right (90 degrees)</td>
</tr>
<tr>
<td><strong>Ctrl + Left/Right</strong></td>
</tr>
<tr>
<td>Rotate by 1 degree</td>
</tr>
<tr>
<td><strong>Ctrl + Shift + Left/Right Arrow</strong></td>
</tr>
<tr>
<td>Rotate by 0.1 degree</td>
</tr>
<tr>
<td><strong>Rotate with Ctrl</strong></td>
</tr>
<tr>
<td>Rotate around common rotation center</td>
</tr>
<tr>
<td><strong>Resize with Shift</strong></td>
</tr>
<tr>
<td>Toggle between resizing types</td>
</tr>
<tr>
<td><strong>Arrows</strong></td>
</tr>
<tr>
<td>Move the selection one pixel at a keystroke</td>
</tr>
<tr>
<td><strong>Shift + Arrows</strong></td>
</tr>
<tr>
<td>Move the selection a few pixels at a keystroke</td>
</tr>
<tr>
<td><strong>Ctrl + G</strong></td>
</tr>
<tr>
<td>Group the selected shapes into one</td>
</tr>
<tr>
<td><strong>Keyboard / Mouse Operation</strong></td>
</tr>
<tr>
<td><strong>Ctrl + E</strong></td>
</tr>
<tr>
<td>Edit Group</td>
</tr>
<tr>
<td><strong>Ctrl + U</strong></td>
</tr>
<tr>
<td>Ungroup</td>
</tr>
<tr>
<td><strong>DRAWING MODES</strong></td>
</tr>
<tr>
<td><strong>Ctrl + 1</strong></td>
</tr>
<tr>
<td>Activate Select tool</td>
</tr>
<tr>
<td><strong>Ctrl + 2</strong></td>
</tr>
<tr>
<td>Activate Text tool</td>
</tr>
<tr>
<td><strong>Ctrl + 3</strong></td>
</tr>
<tr>
<td>Activate Line tool</td>
</tr>
<tr>
<td><strong>Ctrl + 5</strong></td>
</tr>
<tr>
<td>Activate Direct Connector tool</td>
</tr>
<tr>
<td><strong>Ctrl + Alt + 5</strong></td>
</tr>
<tr>
<td>Activate Arc Connector tool</td>
</tr>
<tr>
<td><strong>Ctrl + Shift + 5</strong></td>
</tr>
<tr>
<td>Activate Bezier Connector tool</td>
</tr>
</tbody>
</table>
Keyboard Shortcuts and Mouse Actions

- \(\text{Ctrl} + 6\)  
  Activate Spline tool

- \(\text{Ctrl} + 7\)  
  Activate Rectangle tool

- \(\text{Ctrl} + 8\)  
  Activate Ellipse tool

- \(\text{Ctrl} + 9\)  
  Activate Smart Connector tool

- \(\text{Ctrl} + \text{Alt} + 9\)  
  Activate Curve Connector tool

- \(\text{Ctrl} + \text{Shift} + 9\)  
  Activate Rounded Connector tool

- \(\text{Ctrl} + 0\)  
  Activate Eyedropper tool

- \(\text{F2}\)  
  Activate the Text Editing mode

- Hold down Space  
  Activate Scroll Hand tool

- \(\text{Shift in drawing}\)  
  Constrained drawing (circle, square, etc.)

- \(\text{Alt for drawing or moving objects}\)  
  Invert (activate or disable) the Snap mode

**TEXT FORMATTING**

- \(\text{Ctrl} + \text{Shift} + \text{T}\)  
  Format Text

- \(\text{Ctrl} + \text{B}\)  
  Bold for selected text

- \(\text{Ctrl} + \text{I}\)  
  Italic for selected text

- \(\text{Ctrl} + \text{U}\)  
  Underline selected text

- \(\text{Ctrl} + \text{L}\)  
  Align on the left for selected text

- \(\text{Ctrl} + \text{E}\)  
  Align in the center for selected text

- \(\text{Ctrl} + \text{R}\)  
  Align on the right for selected text

- \(\text{Ctrl} + "."\)  
  Increase font

- \(\text{Ctrl} + ","\)  
  Decrease font

- \(\text{Esc}\)  
  Finish editing

**APPLICATION**

- \(\text{F1}\)  
  Call Help System

- \(\text{Ctrl} + ","\)  
  Preferences (Application Settings)